Supplementary material

Understanding climate change adaptation on Kakadu National Park using a combined diagnostic and modelling framework: a case study at Yellow Water wetland

Leo X. C. Dutra\textsuperscript{A,E,F}, Peter Bayliss\textsuperscript{A}, Sandra McGregor\textsuperscript{B}, Peter Christophersen\textsuperscript{B}, Kelly Scheepers\textsuperscript{C}, Emma Woodward\textsuperscript{C}, Emma Ligtermoet\textsuperscript{C,D} and Lizandra F. C. Melo\textsuperscript{A}

\textsuperscript{A}CSIRO Oceans and Atmosphere Business Unit, Queensland BioSciences Precinct, St Lucia, Qld 4072, Australia.

\textsuperscript{B}Kakadu Native Plants, PO Box 319, Jabiru, NT 0886, Australia.

\textsuperscript{C}CSIRO Tropical Ecosystems Research Centre, Land and Water Business Unit, 564 Vanderlin Drive, Berrimah, NT 0828, Australia.

\textsuperscript{D}The Australian National University (ANU), Fenner School, Canberra, ACT 0200, Australia.

\textsuperscript{E}School of Marine Studies, Faculty of Science, Technology & Environment, The University of the South Pacific, Laucala Bay Road, Suva, Fiji Islands.

\textsuperscript{F}Corresponding author. Email: leo.dutra@csiro.au
**Background to the methods: diagnostic framework**

**Diagnostic framework**

The diagnostic framework proposed by Ostrom (2009, 2007), based on the institutional analysis and development framework (Ostrom 1990), was used to examine ‘the nested attributes of a resource system and the resource units generated by that system that jointly affect the incentives of users within a set of rules crafted by local, distal, or nested governance systems to affect interactions and outcomes over time’ (Ostrom 2007, p. 15181). The framework helps identify relevant variables for studying social–ecological systems (SES), which, in our case study, is important to help elucidate what elements are necessary for adapting to future climate change.

A description of the diagnostic framework is presented below (see Fig. S1 and Table S1) and is taken from (Ostrom 2009) unless otherwise stated. Fig. S1 describes the relationships among core subsystems of an SES that affect one another through linked social, economic and political settings and related ecosystems. The subsystems are (i) resource systems (e.g. a designated protected park encompassing a specified territory containing natural systems), (ii) resource units (e.g. plants or animals in the park, or amount and flow of water), (iii) governance systems (e.g. government and other organisations that manage the park, specific rules related to park use) and (iv) users (i.e. individuals who use the park). Subsystems are made up of multiple second-level variables (e.g. size of a resource system, mobility of a resource unit, level of governance, users’ knowledge of the resource system), which are further composed of deeper-level variables.

We used information from a literature review (Dutra *et al.* 2015a; see the ‘Literature review for diagnostic framework applied to Yellow Water, Kakadu National Park’ section below) to construct the diagnostic framework for the Yellow Water SES. The review identified key governance attributes that support adaptive capacity in coastal Australia, and these attributes are used in our analysis. For the modelling component, we used Kakadu National Park (KNP) management objectives from the literature and elicited during workshops with managers of KNP (Bininj, the Aboriginal people of Kakadu National Park, and Park staff; see Table S2 and Dutra *et al.* 2015b).
Fig. S1. Core attributes in a diagnostic framework for analysing socio-ecological systems (after Ostrom 2009).
Table S1. Detailed framework for analysing a social–ecological systems (SES, from Ostrom 2007)

<table>
<thead>
<tr>
<th>Social, economic, and political setting (S)</th>
<th>Governance system (GS)</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1 Economic development</td>
<td>GS1 Government organisations</td>
</tr>
<tr>
<td>S2 Demographic trends</td>
<td>GS2 Nongovernment organisations</td>
</tr>
<tr>
<td>S3 Political stability</td>
<td>GS3 Network structure</td>
</tr>
<tr>
<td>S4 Government resource policy</td>
<td>GS4 Property rights system</td>
</tr>
<tr>
<td>S5 Market incentives</td>
<td>GS5 Operational rules</td>
</tr>
<tr>
<td>S6 Media organisation</td>
<td>GS6 Collective-choice rules</td>
</tr>
<tr>
<td>Resource system (RS)</td>
<td>GS7 Constitutional rules</td>
</tr>
<tr>
<td>RS1 Sector</td>
<td>GS8 Monitoring and sanctioning processes</td>
</tr>
<tr>
<td>RS2 Clarity of system boundaries</td>
<td></td>
</tr>
<tr>
<td>RS3 Size of resource system</td>
<td></td>
</tr>
<tr>
<td>RS4 Human-constructed facilities</td>
<td></td>
</tr>
<tr>
<td>RS5 Productivity of system</td>
<td></td>
</tr>
<tr>
<td>RS6 Equilibrium properties</td>
<td></td>
</tr>
<tr>
<td>RS7 Predictability of system dynamics</td>
<td></td>
</tr>
<tr>
<td>RS8 Storage characteristics</td>
<td></td>
</tr>
<tr>
<td>RS9 Location</td>
<td></td>
</tr>
<tr>
<td>Resource units (RU)</td>
<td>Users (U)</td>
</tr>
<tr>
<td>RU1 Resource unit mobility</td>
<td>U1 Number of users</td>
</tr>
<tr>
<td>RU2 Growth or replacement rate</td>
<td>U2 Socioeconomic attributes of users</td>
</tr>
<tr>
<td>RU3 Interaction among resource units</td>
<td>U3 History of use</td>
</tr>
<tr>
<td>RU4 Economic value</td>
<td>U4 Location</td>
</tr>
<tr>
<td>RU5 Number of units</td>
<td>U5 Leadership/entrepreneurship</td>
</tr>
<tr>
<td>RU6 Distinctive margins</td>
<td>U6 Norms/social capital</td>
</tr>
<tr>
<td>RU7 Spatial and temporal distribution</td>
<td>U7 Knowledge of SES/mental models</td>
</tr>
<tr>
<td>RU8 Storage characteristics</td>
<td>U8 Importance of resource</td>
</tr>
<tr>
<td>RU9 Location</td>
<td>U9 Technology used</td>
</tr>
<tr>
<td>Interactions</td>
<td>Outcomes</td>
</tr>
<tr>
<td>I1 Harvesting levels of diverse users</td>
<td>O1 Social performance measures</td>
</tr>
<tr>
<td>I2 Information sharing among users</td>
<td>O2 Ecological performance measures</td>
</tr>
<tr>
<td>I3 Deliberation process</td>
<td>O3 Externalities to other SESs</td>
</tr>
<tr>
<td>I4 Conflicts among users</td>
<td></td>
</tr>
<tr>
<td>I5 Investment activities</td>
<td></td>
</tr>
<tr>
<td>I6 Lobbying activities</td>
<td></td>
</tr>
<tr>
<td>I7 Self-organising activities</td>
<td></td>
</tr>
<tr>
<td>I8 Networking activities</td>
<td></td>
</tr>
<tr>
<td>Related ecosystems (ECO)</td>
<td></td>
</tr>
<tr>
<td>ECO1 Climate patterns</td>
<td></td>
</tr>
<tr>
<td>ECO2 Pollution patterns</td>
<td></td>
</tr>
<tr>
<td>ECO3 Flows into and out of focal SES</td>
<td></td>
</tr>
</tbody>
</table>
### Table S2. Objectives from Kakadu National Park (KNP) sourced from the literature

*EPBC Act, Environment Protection and Biodiversity Conservation Act 1999*

<table>
<thead>
<tr>
<th>Fundamental objective</th>
<th>Means objective</th>
<th>Indicator</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effective joint</td>
<td>Ensure that traditional skills and knowledge associated with looking after</td>
<td>Satisfaction of Indigenous people with the level of traditional knowledge that is used in KNP management and implementation of the Plan of</td>
<td>Director of National Parks 2007, pp. 7, 33</td>
</tr>
<tr>
<td>management</td>
<td>culture and country, and Bininj cultural rules regarding how decisions should be</td>
<td>Management and implementation of the Plan of Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>continued to be respected, maintained and integrated with modern KNP management</td>
<td>Satisfaction of Bininj with how well country in being looked after through management of fire, weeds and feral animals and how much</td>
<td>Director of National Parks 2007, pp. 63, 76, 79</td>
</tr>
<tr>
<td></td>
<td>practices</td>
<td>involvement Bininj have in the design and implementation of management programs</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Director of National Parks 2007, p. 38</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Director of National Parks 2010, p. 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Increase Bininj responsibilities in KNP management through capacity building</td>
<td>Number of Bininj trained in modern management practices (i.e. modern park management skills are transferred across to Bininj)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number and type of capacity building initiatives provided for Bininj (including young aboriginals)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Director of National Parks 2007, p. 38</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Director of National Parks 2010, p. 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Facilitate stakeholder engagement and increase satisfaction of stakeholders with</td>
<td>Level of satisfaction of stakeholders with the transparency and accountability of decision-making for the KNP management</td>
<td>Director of National Parks 2007, p. 33</td>
</tr>
<tr>
<td></td>
<td>joint management  Director of National Parks 2007, p. 33; 2010, pp. 7, 8</td>
<td>Perception of quality of initiatives (e.g. workshops, meetings) to formally engage stakeholders to communicate, inform and discuss</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>matters related to KNP management (e.g. fire, weed and feral animal control, climate change)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Director of National Parks 2007, p. 133</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maximise compliance with relevant legislation as a result of effective education</td>
<td>Number, severity and type of non-compliance incidents detected and reported</td>
<td>Director of National Parks 2007, p. 133</td>
</tr>
<tr>
<td></td>
<td>and enforcement programs  Director of National Parks 2007, p. 133</td>
<td>Number of staff trained in compliance and enforcement</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Director of National Parks 2007, p. 133</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maintain World Heritage status for natural values</td>
<td>Abundance of species of natural significance</td>
<td></td>
</tr>
<tr>
<td>Fundamental objective</td>
<td>Means objective</td>
<td>Indicator</td>
<td>Reference</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Effective protection and conservation of biodiversity</td>
<td>Conserving the distribution, abundance and diversity of native plants and animals and communities is a fundamental objective of Kakadu National Park management. For the most effective approach to management of native plant and animal populations, land management programs must integrate fire, weed, feral animal and visitor management considerations.</td>
<td>Area of floodplain with acceptable levels of weeds</td>
<td>Director of National Parks 2007, p. 68; 2010, p. 6</td>
</tr>
<tr>
<td>Maintain floodplain function and structure (healthy ecosystems)</td>
<td>Maintain floodplain function and structure (healthy ecosystems)</td>
<td>Proportion of floodplain area affected by unplanned or adverse fires</td>
<td>Director of National Parks 2007, p. 63</td>
</tr>
<tr>
<td>Protection and conservation of cultural values (EPBC Act)</td>
<td>Maintain or increase traditional knowledge (spiritual, cultural, environmental)</td>
<td>Percentage of roads and tracks that provide access to spiritual/cultural sites not affected by weeds, ferals and permanent inundation permanently inundated (salt- and freshwater) Number of Bininj involved in businesses based on commercial use of wildlife (i.e. opportunities to be out on country) Extent to which Bininj are satisfied that people are using country in accordance with traditional law ‘Healthy ecosystems’: abundance of species important to Bininj customary economy, ceremonial responsibilities and land management practices</td>
<td>Director of National Parks 2007, p. 32 Director of National Parks 2007, p. 73 Director of National Parks 2007, p. 40 Director of National Parks 2007, pp. 40, 67</td>
</tr>
<tr>
<td>Fundamental objective</td>
<td>Means objective</td>
<td>Indicator</td>
<td>Reference</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ensure aboriginal people are able to look after country</td>
<td>Protection of cultural sites with acceptable levels of weed infestation</td>
<td>Director of National Parks 2007, pp. 32, 56</td>
<td></td>
</tr>
<tr>
<td>(protection of landscapes, soils and water)</td>
<td>Proportion of cultural sites with acceptable impacts of saltwater intrusion (i.e. occasional king tides and storm surges)</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Proportion of cultural sites with acceptable impacts of feral animals</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Area with acceptable level of weed infestation</td>
<td>Director of National Parks 2007, p. 32</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Level of visitor and tourism industry satisfaction with recreational and tourism opportunities in the KNP</td>
<td>Director of National Parks 2007, p. 85</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Net present value associated with harvest of natural resources</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Improve sustainable economic benefits to Bininj (Director of National Parks 2007, pp. 32, 73, 79)</td>
<td>Number of skilled, unskilled, temporal and permanent jobs related to tourism</td>
<td>Director of National Parks 2007, p. 9</td>
<td></td>
</tr>
<tr>
<td>Protection of natural and scenic areas (Yellow Water floodplains) for tourist purposes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Level of visitor and tourism industry satisfaction with recreational and tourism opportunities in the KNP</td>
<td>Director of National Parks 2007, p. 85</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Net present value associated with harvest of natural resources</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Number of skilled, unskilled, temporal and permanent jobs related to tourism</td>
<td>Director of National Parks 2007, p. 9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Level of Bininj satisfaction with management of fishing and boating, and their involvement in planning and management of these activities</td>
<td>Director of National Parks 2007, p. 103</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Linear channel changes in the tidal-interface region</td>
<td>Petty et al. 2005</td>
<td></td>
</tr>
<tr>
<td>Ensure responsible boating and recreational fishing</td>
<td>Level of visitor satisfaction with fishing and boating opportunities</td>
<td>Director of National Parks 2007, p. 9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Level of Bininj satisfaction with management of fishing and boating, and their involvement in planning and management of these activities</td>
<td>Director of National Parks 2007, p. 103</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Linear channel changes in the tidal-interface region</td>
<td>Petty et al. 2005</td>
<td></td>
</tr>
<tr>
<td>Promote social well being</td>
<td>Impact on cultural and recreational sites</td>
<td>Director of National Parks 2007, p. 32</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Proportion of area used for recreational and cultural purposes are accessible (i.e. within acceptable levels of weed infestation, feral animal damage, and inundation)</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Fundamental objective</td>
<td>Means objective</td>
<td>Indicator</td>
<td>Reference</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------</td>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bininj perception that visitor impacts are within acceptable levels. Level of Bininj satisfaction with the nature, scope and impact of recreational (rec fishing, boating) and tourism opportunities in the KNP</td>
<td>Director of National Parks 2007, p. 85</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Promote Bininj satisfaction</td>
<td>Director of National Parks 2007, pp. 32, 73, 79</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Proportion of Indigenous people working on land-related activities (e.g. fire management, land management, hunting, gathering, arts and crafts, bush tucker tours, hunting, feral and weed control etc.)</td>
<td>Director of National Parks 2007, pp. 32, 73, 79</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number of Indigenous enterprises that make significant contributions to maintenance of cultural values of the KNP</td>
<td>Director of National Parks 2007, p. 73</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Improve health and safety in Kakadu</td>
<td>Director of National Parks 2007, p. 103</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number and seriousness of safety related incidents</td>
<td>Director of National Parks 2007, p. 103</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number of crocodiles in areas where swimming is allowed or in locations that present a higher than usual risk to people</td>
<td>Director of National Parks 2007, p. 69</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Extent to which potable drinking water at KNP facilities is in accordance with Australian Drinking Water Guidelines</td>
<td>Director of National Parks 2007, p. 56</td>
</tr>
</tbody>
</table>
Literature review for diagnostic framework applied to Yellow Water, Kakadu National Park

The critical factors affecting the Yellow Water social-ecological system (SES) under the headings identified by Ostrom (2007, 2009) were identified from a literature review and summarised in Table S3. Yellow Water (YW) contains Ramsar-listed wetlands and associated floodplains and is also a World Heritage Area for its cultural and biodiversity values (S).

Floodplains and wetlands from KNP support a variety of plants and animals, which are important economic and cultural resources for Aboriginal people (RS1). These habitats have sustained traditional Aboriginal economies for thousands of years. Bininj continue to use and manage these resources. Yellow Water wetlands are also a major focus of Kakadu’s tourism industry, which also provide economic opportunities through local businesses and jobs (McGregor et al. 2010). Conflicts occur sometimes between Bininj and some KNP users over clarity of system boundaries (RS2). For example, some KNP users have a different perception about land rights of aboriginal land-owners within the KNP and the role these land-owners have in KNP decisions (Palmer 2004).

The size of the YW SES is important because the species harvested occur in a limited area (RS3). The human-constructed facilities (RS4) are composed of KNP’s infrastructure (buildings and roads (Director of National Parks 2007, p. 58), tourism infrastructure (accommodation (Gagadju Lodge Cooinda; BMT WBM 2011, p. 70; McGregor et al. 2010), roads and bridges (Boustead 2009, p. 31; Hyder Consulting Pty Ltd 2008; Director of National Parks 2010, 2016) and housing (Hyder Consulting Pty Ltd 2008; Director of National Parks 2010).

The resources (plants and animals) are renewable (RS5) and their predictability is influenced by seasonal (monsoonal) wet–dry cycles (RS6). The wet season (November to March) is characterised by heavy periodic rains and generally hot and humid conditions. The dry season (April to October) is characterised by dry and mild to warm conditions (Finlayson and Oertzen 1996, p. 4). Most of the 1300–1500 mm of annual rainfall comes from monsoonal depressions and intense downpours during the wet season. The climate dynamics is very complex because of inter-annual and inter-decadal weather patterns that include rain bearing monsoonal fronts and cyclones (Finlayson and Oertzen 1996, p. 4).

Resource Units (RU) are animals and plants used by Indigenous people that inhabit, feed and breed in YW floodplains (Bayliss and Yeomans 1990, p. 77; Director of National Parks 2007; McGregor et al. 2010). The animals, especially the waterbirds, pigs (invasive species) and fish are mobile. Some species, such as the magpie geese perform long annual migration and these migration cycles and breeding seasons are taken into consideration in determining hunting
seasons. Fish, such as the barramundi, catfish, saratoga, black bream and freshwater turtles are an important resource for Aborigines and KNP visitors (Palmer 2004). Plants such as water lilies and lotus seeds also grow in the floodplains and are part of Aboriginal diet (McGregor et al. 2010).

Growth or replenishment rate of harvested species (RU2) depend on complex ecological processes related to annual patterns of rainfall and floodplain inundation, occasional saltwater intrusion, fire regimes and management, abundance of native grasses (especially \textit{Hymenachne acutigluma}) and invasive species (feral animals (e.g. buffaloes, pigs, horses) and weeds; Bayliss and Yeomans 1990; Skeat et al. 1996; Douglas and O’Connor 2004; Petty et al. 2005; Director of National Parks 2007; McGregor et al. 2010; Woodward et al. 2010; BMT WBM 2011; Setterfield et al. 2013). River shape, tidal flow, vegetation cover or landform can facilitate the entry of saltwater into freshwater areas, which in the short term negatively affects freshwater vegetation and the animals it sustains (Director of National Parks 2007, p. 57).

Fire is a major RU2 driver because it affects plant and animal growth and abundance. It is a natural part of the floodplain landscape and a fundamental expression of Aboriginal knowledge and the connection of Aboriginal people to their environment. Indigenous people have used fire as a management tool for thousands of years, to encourage the regrowth of desired grasses and to clear access to hunting and cultural sites. This traditional practice has created a mosaic of unburnt, early and late-burnt patches that is important for maintaining species and habitat diversity (Russell-Smith et al. 1995; Petty et al. 2005, p. 40, 2007, p. 5; Director of National Parks 2007, pp. 63, 64; McGregor et al. 2010). Invasive species (weeds and feral animals) also affect growth and replenishment rates of important plants and animals. Aquatic weeds alter natural fire regime (Douglas and O’Connor 2004; Boustead 2009) and feral animals affect ecological relationships between plants and animals and also facilitate the dispersal of weeds (Skeat et al. 1996, p. 161; Director of National Parks 2007, p. 79; Woodward et al. 2010). Altered fire regimes and the spread of weeds and feral animals have influenced the composition of native plant and animal communities in the KNP (Director of National Parks 2007, p. 67).

Resource units strongly interact (RU3). For example, plant species (e.g. sedge, \textit{Eleocharis dulcis}, and surrounding wild rice, \textit{Oryza} spp.) form preferred nesting and feeding grounds for magpie geese (\textit{Anseranus semipalmata}). Hydraulic connectivity (floodplain inundation and saltwater intrusion) is also an important element of interaction between resource units (RU3) (McGregor et al. 2010). Other examples of interactions among resource units are provided as follows: the invasive species para grass is spreading across KNP. This weed can alter the natural fire regime by displacing native plants (e.g. wild rice). Para grass increases the fuel load, resulting in more intense fires and flame height, which can cause deaths of native \textit{Melaleuca} trees, monsoon rainforest species and turtles aestivating in the mud (Douglas and O’Connor
2004). Increased spread of weeds (such as para grass) into magpie goose habitat is likely to
decrease the availability of food sources such as wild rice and *Eleocharis* spp. (Bayliss and
Yeomans 1990). Buffalo were widespread in Yellow Water in the past (Petty et al. 2005) and
caused significant impacts by grazing, trampling and the formation of pads and wallows.
Buffalo impacts include the following (Skeat et al. 1996, p. 159; Petty et al. 2005; Woodward
et al. 2010): (1) reduction in vegetation biomass, change in species composition (including
dispersal of weeds) and, locally, complete removal of vegetation, which affect population of
birds such as the magpie geese; (2) compaction of soils and soil erosion; (3) changes to surface
hydrology, including reduced retention of fresh water in flood basins and intrusion of saltwater
into freshwater swamps; and (4) increased turbidity in water bodies resulting from trampling,
wallowing and grazing, as well as their contamination by buffalo faeces and urine. It is,
therefore, paramount to maintain numbers of feral animals low through active population
control.

Floodplain species are an important economic asset for aboriginal communities in Yellow
Water (RU4). For example, the value of wild harvested magpie goose can be as high as AU$20
per bird (Australian Greenhouse Office 2004), and their hunting provides important economic
(as well as social and cultural) benefits to aboriginal people. The floodplains are also a major
focus of the tourism industry in Yellow Water. Tourist visitation depends on good ecological
conditions of floodplains (Prouse and Crawford 2006, p. 4). Economic benefits associated with
the tourism industry include opportunities for jobs and local businesses (Director of National
Parks 2007, p. 85; McGregor et al. 2010; Harris 2012, p. 74). The importance of tourism in
Yellow Water is enormous for the whole KNP as the tourist resort of Cooinda, next to Yellow
Water floodplains, is the most visited site of KNP and the floodplains constitute the main
attraction for tourists (Tremblay 2006).

The dynamics of the Yellow Water SES is driven by a combination of biophysical processes,
human use and relationships between managers and users (U, GS1, GS2), i.e. traditional land
owners (TO), Parks Australia and KNP users. Aboriginal people have been using and managing
natural resources in Yellow Water for thousands of years (U3). The resources are important for
economic and socio-cultural reasons and also for their biodiversity values (Ramsar, World
Heritage status; U8; McGregor et al. 2010).

As part of KNP Yellow Water is governed by a joint-management arrangement (GS)
between the Director of National Parks (Parks Australia; GS1) and Bininj (GS2), which enables
Indigenous people to participate in conservation planning and country management (Director
of National Parks 2007, p. 67; McGregor et al., 2010). Joint management brings together two
distinct governance systems operating in parallel (GS3), namely (1) an Indigenous nodal system
that has evolved over the millennia to manage natural and cultural resources and (2) a more
recent non-Indigenous hierarchical system created to manage KNP in 1978. We provide below a synthesis about these governance systems, on the basis of previous published work (Robinson et al. 2005; Director of National Parks 2007; Woodward et al. 2010), unless otherwise stated.

Smith (2008) describes Indigenous governance systems in northern Australia as decentralised, based on laws, kinship and marriage systems, behavioural and gender norms, family values, religious beliefs and moral system, principles of land ownership (GS4), ceremony and ritual. Bininj governance can be understood as a ‘nodal network’ where its members (nodes) are essentially autonomous units that are interconnected and interdependent (GS3). This ‘governance network’ emphasises the interconnected distribution and exercise of a group’s decision-making and shared leadership to achieve collective goals. There are particular decision-making nodes in the network represented by male and female leaders. These leaders have respect and influence within their communities and are able to mobilise people and resources to create order and collectively get things done. Leadership is, therefore, shared through the nodes, and constitute the circuitry of governing order and authority that enables things to be achieved over time (G6). Central to the Bininj governance system is the set of institutions, or rules, that enable nodal leaders to legitimately activate social networks (GS3; Smith 2008). Such networks are also at the core of the process of knowledge production (Palmer 2004).

Palmer (2004) asserted that ‘in Bininj negotiations, attention is typically paid to the landowners’ primary rights to speak for country and resources, while at the same time respectfully recognising the perspective of others (GS5, p 72). In this way, the negotiation practices among land-owning groups involve attention both to the legitimacy of individuals representing groups of others, and ‘an acceptance of the rights of participants to speak for their own territories’ (GS8).

The non-Indigenous hierarchical system created to manage KNP is supported by two constitutional rules (GS7), which are as follows:

(1) The Land Rights Act provides for the granting of land to Aboriginal Land Trusts for the benefit of the traditional Aboriginal owners and requires land granted in the Alligator Rivers Region to be leased to the Director of National Parks (Director of National Parks 2007, p. 7, 2016).

(2) The Commonwealth Environmental Protection and Biodiversity Conservation Act 1999 (EPBC Act). The EPBC Act provides for the KNP to be managed by the Director, in conjunction with the Bininj through a Board of Management that has a majority of members who are nominated by Bininj (the joint-management arrangement). The EPBC Act gives the Director the function of administering, managing, controlling and protecting
biodiversity and heritage in the KNP, including power to determine KNP entry and use charges to control certain activities, veto and to issue permits. The Director must perform these functions and use these powers in accordance with the KNP Management Plan. Under the KNP leases, the Director is required to consult with Northern Land Council (NLC) about general KNP management issues and also in preparation of the management plans. The KNP is, therefore, not public land but privately owned by Bininj (GS4), even though the perception of some park users is that KNP is public land (Palmer 2004). This misconception causes conflicts between Bininj and KNP users (I4) because of different ideas on how the KNP should be managed, which is heavily influenced by differences in perception, world views and values (for details, refer to Palmer 2004).

The Board of Management (BoM) has Indigenous majority, which allows for strong representation of Bininj in the decision-making process. The Board has the function of preparing the Management Plan with the Director, who will comply with the decisions of the Board that give effect to the plan. Parks Australia staff assists the Director and manages daily operations of the KNP in consultation with Bininj. The BoM meets every 3 months and generally makes high-level policy and strategic decisions about KNP management. Park staff make day-to-day management decisions and exercise powers on behalf of the Director in accordance with the Management Plan, Board decisions and the EPBC Act and other legislation.

The Board established Advisory Committees (e.g. Kakadu Tourism Consultative Committee (KTCC) and the Kakadu Research and Management Advisory Committee (KRMAC) to help the Board make informed decisions. The KTCC provides the Board with advice on tourism issues and the views of tourism stakeholders in a structured way. The KRMAC provides advice to the Board on research issues and priorities for the KNP.

One consequence of the Bininj governance structure is that because of customary decision-making structures (i.e. collective-choice rules; GS6), Bininj members of the BoM (GS5) are reluctant to make decisions that directly affect the rights and obligations of other Bininj on their country (Field et al. 2006). The model of stakeholder negotiation within the hierarchical governance structure of KNP ‘aims to balance competing interests’. The ontological differences in value systems between Bininj and non-Indigenous managers makes the negotiation process between them sometimes difficult; from a Bininj standpoint, power is unequal because (under their value system) it does not follow customary laws, but from a non-Indigenous perspective, power is equal because interests were balanced by allowing parties to argue pro or against decisions (Palmer 2004). Palmer stresses that third-party interest groups, such as the tourism and fishing industries, which are outside the KNP’s formal joint-management arrangements,
assert their own ideologies and environmental management visions for the KNP and complicate
the joint-management situation by demanding even further compromises by Bininj.

Climate change is expected to pose a major threat to Yellow Water socio-ecological system
(ECO1) by saltwater intrusion, and changes in fire and rainfall regimes (Pett y et al. 2005, p.
44; Hyder Consulting Pty Ltd 2008; BMT WBM 2011, p. 60; CSIRO 2012, 2013). These
factors will alter the dynamics between native and invasive species, which will create
challenges and also opportunities for Aboriginal communities that depend on Yellow Water
resources.
Table S3. Literature sourced to complete Ostrom’s diagnostic framework

*EPBC Act, Environment Protection and Biodiversity Conservation Act 1999*

<table>
<thead>
<tr>
<th>Resource system (RS)</th>
<th>Yellow Water floodplains located in a National Park</th>
<th>Governance system (GS)</th>
<th>Co-management</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS1 Sector</td>
<td>Conservation</td>
<td>GS1 Government organisations</td>
<td>Parks Australia</td>
</tr>
<tr>
<td>RS2 Clarity of system boundaries</td>
<td>Boundaries and ownership of some land are still under negotiation</td>
<td>GS2 Nongovernment organisations</td>
<td>Northern Land Council</td>
</tr>
<tr>
<td>RS3 Size of resource system</td>
<td>Finite size (plant and animal populations within wetlands and floodplain boundaries; McGregor <em>et al.</em> 2010)</td>
<td>GS3 Network structure</td>
<td>Indigenous governance are ‘nodal network’ where its members (nodes) are essentially autonomous units that are interconnected and interdependent (Smith 2008)</td>
</tr>
<tr>
<td>RS4 Human-constructed facilities</td>
<td><strong>Parks infrastructure</strong> - buildings (Director of National Parks 2007, p. 58, 2016) - roads)</td>
<td>GS4 Property rights system</td>
<td>Land is privately owned by Bininj and leased back to the Director of National Parks (Palmer 2004; Director of National Parks 2007, 2016)</td>
</tr>
</tbody>
</table>

*Tourism infrastructure*
- accommodation (Gagadju Lodge Cooinida; McGregor *et al.* 2010; BMT WBM 2011, p. 70)

*Roads and bridges* (Boustead, 2009, p. 31; Hyder Consulting Pty Ltd 2008; Director of National Parks 2010)
**Housing** (Hyder Consulting Pty Ltd 2008; Director of National Parks 2010).

| RS5 Productivity of system | Renewable resources | GS5 Operational rules | Kinship and marriage systems, behavioural and gender norms, family values, religious beliefs and moral system, principles of land ownership, ceremony and ritual (Smith 2008). In Bininj negotiations, attention is typically paid to the landowners’ primary rights to speak for country and resources, while at the same time respectfully recognising the perspective of others (Palmer 2004).

The Board of management meets every 3 months and generally makes high-level policy and strategic decisions about KNP management. Park staff make day-to-day management decisions and exercise powers on behalf of the director in accordance with the management plan, Board decisions and the *EPBC Act* and other legislation.

| RS6 Equilibrium properties | GS6 Collective-choice rules | Follow wet–dry cycle: | *The Land Rights Act* provides for the granting of land to Aboriginal Land Trusts for the benefit of the traditional Aboriginal owners and requires land granted in the Alligator Rivers Region to be leased to the Director of National Parks (Director of National Parks 2007, p. 7, 2016).

The *EPBC Act* provides for the KNP to be managed by the Director in conjunction with the Bininj through a Board of Management that has a majority of members who are nominated by Bininj. The *EPBC Act* requires the composition of the Board to be agreed between the Minister (who appoints Board members) and the Northern Land Council (Director of National Parks 2007, p. 7, 2016).

| RS7 Predictability of system dynamics | GS7 Constitutional rules | Seasonal |

| RS8 Storage characteristics | GS8 Monitoring and sanctioning processes | Users (U) |

| RS9 Location | Bininj | Inter-annual |

| Inter-decadal |
Resource units (RU)

Plants and animals inhabiting floodplains (magpie geese, ducks, water lilies, yams, freshwater turtles, file snake, goanna – among other species known as ‘bush tucker’) (Bayliss and Ligtermoet 2017; Director of National Parks 2007, p. 77, 2016; McGregor et al. 2010)

RU1 Resource unit mobility

Mobile animals (fish waterbirds, turtles, pigs, buffaloes) that feed and breed on floodplain vegetation and plants used by Indigenous people (lilies and yams) (Bayliss and Yeomans 1990; Palmer 2004; McGregor et al. 2010; Harris 2012, p. 74)

RU2 Growth or replacement rate

Growth or replenishment rate of harvested species in Yellow Water depend on complex ecological processes related to rainfall and freshwater flow into the floodplains, occasional saltwater intrusion, fire regimes and management, abundance of grasses and invasive species (feral animals (e.g. buffaloes, pigs, horses) and weeds) (Bayliss and Yeomans 1990; Skeat et al. 1996, p. 161; Douglas and O’Connor 2004; Petty et al. 2005; Director of National Parks 2007, 2016; McGregor et al. 2010; BMT WBM 2011, p. 12; Setterfield et al. 2013)

Growth or replenishment rate of harvested species (e.g. magpie geese, barramundi, freshwater turtles and water lilies) depend on seasonal inundation of floodplains, as well as on the amount of saltwater that enters the floodplain. River shape tidal flow, vegetation cover or landform can facilitate the entry of salt water into freshwater areas, with flow on negative effects on vegetation and animals (Boustead 2009, pp. 45, 46; Director of National Parks 2007, p. 57, 2016).

Fire is a major driver of plant and animal growth and abundance. It is a natural part of the floodplain landscape and a fundamental expression of Aboriginal knowledge of their local ecology and their connection to their environment. Indigenous people have used fire as a management tool to encourage the regrowth of desired grasses and clear access for thousands of years (Boustead 2009, pp. 58, 59; Director of National Parks 2007, pp. 63, 64, 2016; Petty et al. 2007, p. 5; McGregor et al. 2010).

U1 Number of users

Small number of users (families)

U2 Socioeconomic attributes of users

Tourists
Invasive species (weeds and feral animals) also affect growth and replenishment rates of important plants and animals. Weeds also alter the natural fire regime (Douglas and O’Connor 2004; Bousted 2009, pp. 40, 41). Feral animals affect ecological relationships between plants and animals and also facilitate the dispersal of weeds (Skeat et al. 1996, p. 161; Director of National Parks 2007, p. 79, 2016). Altered fire regimes and the spread of weeds and feral animals have influenced the composition of native plant and animal communities in the KNP (Director of National Parks 2007, p. 67, 2016).

Aboriginal people have been using and managing natural resources in the region for thousands of years. The KNP was established in 1978 and, since then, it has been jointly managed by traditional land owners and Parks Australia (Director of National Parks 2007, p. 67; Bousted 2009, p. 40; McGregor et al. 2010).

RU3 Interaction among resource units
Connectivity within Yellow Water and between riverine, lacustrine and coastal waters (BMT WBM 2011, p. 17). Interaction between plant species (e.g. sedge Eleocharis dulcis, and wild rice, Oryza spp.), which form preferred nesting and feeding grounds for magpie goose, Anseranus semipalmata, is influenced hydraulic connectivity (saltwater intrusion; McGregor et al. 2010).

RU4 Economic value
Magpie goose are an important source of food for Indigenous people. The value of wild harvested magpie goose is AU$20 per bird (Bousted 2009, p. 42). The floodplains are a major focus of the tourism industry in Yellow Water and tourist visitations depend on good ecological conditions of floodplains (Prouse and Crawford 2006, p. 4). Tourism provides economic opportunities for jobs and local businesses (Director of National Parks 2007, p. 85, 2016; McGregor et al. 2010; Harris 2012, p. 74). The tourist resort of Cooinda, next to Yellow Water floodplains, was recorded as the most visited site of KNP and the floodplains constitute the main attraction for tourists (Tremblay 2006, quoted in Bousted 2009, p. 31)

RU5 Number of units
RU6 Distinctive margins

U3 History of use
Aboriginal people have been using and managing natural resources in the region for thousands of years. The KNP was established in 1978 and, since then, it has been jointly managed by traditional land owners and Parks Australia (Director of National Parks 2007, p. 67; Bousted 2009, p. 40; McGregor et al. 2010).

U4 Location
The floodplains are a major focus of the tourism industry in Yellow Water and tourist visitations depend on good ecological conditions of floodplains (Prouse and Crawford 2006, p. 4). Tourism provides economic opportunities for jobs and local businesses (Director of National Parks 2007, p. 85, 2016; McGregor et al. 2010; Harris 2012, p. 74). The tourist resort of Cooinda, next to Yellow Water floodplains, was recorded as the most visited site of KNP and the floodplains constitute the main attraction for tourists (Tremblay 2006, quoted in Bousted 2009, p. 31)

U5 Leadership/entrepreneurship
U6 Norms/social capital

Page 18 of 73
<table>
<thead>
<tr>
<th>RU7 Spatial and temporal distribution</th>
<th>U7 Knowledge of SES/mental models</th>
<th>Economic (subsistence), socio-cultural activities (Boustead, 2009, p. 42; McGregor et al. 2010)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interactions (I) → outcomes (O)</td>
<td>U8 Importance of resource</td>
<td>Satisfaction of Indigenous people with the level of traditional knowledge that is used in KNP management and implementation of management Plan (Director of National Parks 2007, pp. 7, 33)</td>
</tr>
<tr>
<td>I1 Harvesting levels of diverse users</td>
<td>U9 Technology used</td>
<td>Satisfaction of Bininj with how well country in being looked after through management of fire, wees and feral animals and how much involvement Bininj have in the design and implementation of management programs (Director of National Parks 2007, pp. 63, 76, 79; 2016)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number of Bininj trained in modern management practices (i.e. modern park management skills are transferred across to Bininj) (Director of National Parks 2007; p. 38, 2016)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Number and type of capacity building initiatives provided for Bininj (including young Aboriginals) (Director of National Parks 2010, p. 5)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Level of satisfaction of stakeholders with the transparency and accountability of decision-making for the KNP’s management (Director of National Parks 2007, p. 33, 2016).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Proportion of Indigenous people working on land-related activities (such as e.g. fire management, land management, hunting, gathering, arts and crafts, bush tucker tours, hunting, feral and weed control; Director of National Parks 2007, pp. 32, 73, 79, 2016)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Abundance of species of natural and cultural significance (Director of National Parks 2007, p. 68; 2010, p. 6; 2016)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Area of floodplain with acceptable levels of weeds (Director of National Parks 2007, p. 13, 2016)</td>
</tr>
<tr>
<td>I2 Information sharing among users</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Through the board of management. Indigenous people are also employed in the KNP.</td>
<td></td>
</tr>
</tbody>
</table>

The tourism industry fears the loss of freshwater wetlands in Kakadu may reduce the appeal of Kakadu as a tourist destination and, therefore, lead to a drop in visitation (Boustead 2009, p. 13).
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>I3 Deliberation process</td>
<td>Board of management is formalised around a western governance structure (Haynes 2009, p. 70)</td>
</tr>
<tr>
<td>I4 Conflicts among users</td>
<td>Between Indigenous families Between Bininj and parks Between (the Aboriginal people of Kakadu National Park) Bininj and Park users (tourists and fishers; Palmer 2004)</td>
</tr>
<tr>
<td>I5 Investment activities</td>
<td>O3 Externalities to other SESs</td>
</tr>
<tr>
<td>I6 Lobbying activities</td>
<td>Climate change (rise in sea level, temperature and changes in fire regimes and cyclonic activities)</td>
</tr>
<tr>
<td>I7 Self-organising activities</td>
<td></td>
</tr>
<tr>
<td>I8 Networking activities</td>
<td></td>
</tr>
</tbody>
</table>

**Related ecosystems (ECO):** woodlands, estuaries, escarpments

| ECO1 Climate patterns | Monsoons (wet–dry cycle) |
| ECO2 Pollution patterns | |
| ECO3 Flows into and out of focal SES | Tourists, migratory species (waterbirds) |
Fig. S2. Conceptual diagram of the Yellow Water social–ecological system.
**Report on functional design of levee to protect Yellow Water from sea-level rise (including brief with specifications and memo commenting on barrier proposal)**

**Brief describing the problem**

Yellow Water is located at the South Alligator River and is one of the floodplains within Kakadu National Park and includes World Heritage and Ramsar-listed wetlands (seasonal river-floodplains) that support a variety of freshwater plants and animals used by local Indigenous people. Indigenous culture and biodiversity values are also highly important for the tourism industry, which brings important economic benefits in the form of Indigenous businesses and jobs. Predicted sea-level rise associated with climate change is expected to affect Yellow Water by saltwater inundation of (1) freshwater ecosystems, (2) cultural sites and (3) infrastructure (e.g. housing, roads, tourist facilities), with flow on effects on Indigenous livelihoods.

The construction of levy banks have the potential to protect biodiversity and Indigenous values in Yellow Water from saltwater intrusion so the floodplain can continue to provide ecosystem goods and services for future generations. We would like to assess the feasibility of protecting biodiversity, cultural and economic (Indigenous businesses and jobs) values in Yellow Water by the construction of a levy bank that stops saltwater intrusion associated with predicted sea-level rise in the floodplain during the dry season and allows the freshwater to flow during the wet season so that habitat connectivity is maintained. Designing such a levy bank also involves the choice of a suitable location and costs associated with its construction and maintenance. This information is critical to KNP managers to make an assessment of its feasibility and plan for adaptation options given the predicted sea-level rise for this century.

The following data are available:

- Digital elevation model: LiDAR

- Outputs from a hydraulic model for four sea-level rise (SLR) scenarios (Present (0 m SLR), 2030 (0.14 m SLR), 2070 (0.70 m SLR), 2100 (1.1 m SLR). Model was run during the dry season for a period of 8 days in 15-min time steps. Highest tidal input was 3.39 m (AHD) at the mouth of the South Alligator River.

- Mean water level at the South Alligator River during a typical dry season (October 2005) is 0.66 m (AHD), maximum tide 3.75 m (AHD) and minimum water level is –1.86 m (AHD).

- There are several tidal and rainfall gauge stations (water level/flow and rainfall from Northern Territory Government and rainfall from the Bureau of Meteorology) in the South Alligator River (see Table S4 below).
### Table S4. Gauge stations from Northern Territory Government (NRETAS)

<table>
<thead>
<tr>
<th>Station ID</th>
<th>Station location</th>
<th>Agency</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Latitude/longitude datum</th>
<th>Elevation (m; AHD)</th>
<th>Catchment area (km²)</th>
<th>Attributes</th>
<th>Frequency</th>
<th>Commence</th>
<th>Cease</th>
</tr>
</thead>
<tbody>
<tr>
<td>G8200045</td>
<td>South Alligator River at El Sherana</td>
<td>NRETAS</td>
<td>1300</td>
<td>–</td>
<td>GDA94</td>
<td>32.691</td>
<td>10 132</td>
<td>Cumecs ML⁻¹ day⁻¹</td>
<td>Daily or monthly</td>
<td>19 580 818</td>
<td></td>
</tr>
<tr>
<td>G8200005</td>
<td>South Alligator Plain at Arnhem Highway</td>
<td>NRETAS</td>
<td>–</td>
<td>132.5178</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>19 690 803</td>
<td>20 110 120</td>
</tr>
<tr>
<td>G8200044</td>
<td>Goodparla Creek at Coirwong Gorge</td>
<td>NRETAS</td>
<td>–12.6485</td>
<td>132.5178</td>
<td>GDA94</td>
<td>32.691</td>
<td>10 132</td>
<td>Cumecs ML⁻¹ day⁻¹</td>
<td>Daily or monthly</td>
<td>19 601 111</td>
<td>19 800 926</td>
</tr>
<tr>
<td>G8200111</td>
<td>Jim Jim Creek at Oenpelli Road Crossing</td>
<td>NRETAS</td>
<td>–</td>
<td>132.7410</td>
<td>GDA94</td>
<td>32.713</td>
<td>2220</td>
<td>Cumecs ML⁻¹ day⁻¹</td>
<td>Daily or monthly</td>
<td>19 601 111</td>
<td>20 061 101</td>
</tr>
<tr>
<td>G8200112</td>
<td>Nourlangie Creek at Kakadu Highway</td>
<td>NRETAS</td>
<td>–12.8184</td>
<td>132.7410</td>
<td>GDA94</td>
<td>32.713</td>
<td>2220</td>
<td>Cumecs ML⁻¹ day⁻¹</td>
<td>Daily or monthly</td>
<td>19 601 111</td>
<td>20 061 101</td>
</tr>
</tbody>
</table>
Yellow Water information

The following information relates to the desktop study prepared by Woodroffe et al. (1986).

- South Alligator River has a catchment area of 9000 km$^2$.
- Tidal influence up to 105 km up the river.
- Annual flows in the wet season are 400–700 m$^3$ s$^{-1}$.
- From fig. 2 of Woodroffe et al. (1986), catchment at Yellow Water approximately half of the total catchment.
- 275 mm of rainfall in March with 33% runoff
- This would give and average flow at Yellow Water of 150 m$^3$ s$^{-1}$ for the month of March, calculated as follows: 9000 km$^2$/2 × 100 ha × 10 000 m$^2$ × 0.275 m × 0.33/31 days × 24 h × 60 min × 60 s
- Fig. 7 of Woodroffe et al. (1986) gives a band of 3000–5000 m$^3$ s$^{-1}$ for a 1% event for the total catchment.
- In ‘2.2 Tidal behaviour’, there is some discussion of flood recording at Arnhem Highway. This is downstream of Yellow Water and ~80% of the catchment flows through. A flood of March 1984 was recorded to have a flow of 800 m$^3$ s$^{-1}$, but 300–500 m$^3$ s$^{-1}$ was said to be receding tide. This is ~70 km inland, where the river width is shown as 500 m and mean tide flows are said to be 1000 m$^3$ s$^{-1}$.
- Figs 16 and 19 of Woodroffe et al. (1986) indicate that river width and tidal flows drop off quickly upstream of the Arnhem Highway, with width down to 100 m at 85 km inland and tidal flow down to 150 m$^3$ s$^{-1}$ at this point.
- Fig. 17 of Woodroffe et al. (1986) shows a tidal range of 3.3 m some 63 km inland with the spring tide. The river is 500 m wide at this point.

Estimations from the above information

It appears that cross-section information and the tidal range are not available at the downstream end of Yellow Water where it is suggested that some form of barrier could be built. Any barrier would need to exclude salt-laden tidal flow but allow flows from upstream through in a way close to the existing flow regime. A flood gated barrier may be able to do this, but some form of fish ladder is likely to be required.

Assuming a river width of 100 m and tidal range of 3 m, a preliminary sizing of culverts and a weir was undertaken, assuming a total height from low tide to high tide of ~3 m. Pipes or culverts 2.44 m high, with the top of bank ~0.6 m above the overt were assumed.
On the basis of the catchment at Yellow Water being approximately half the total catchment, the annual wet season flows were calculated to be \(\approx 275 \text{ m}^3\text{s}^{-1}\), using the average between 400 and 700 m\(^3\) s\(^{-1}\) and half the catchment area \(((400 + 700)/2 \times 2 = 275)\). Similarly, the \(Q_{100}\) flow was estimated to be \(2000 \text{ m}^3\text{s}^{-1}\) \(((3000 + 5000)/2 \times 2 = 2000)\).

**Using a levee downstream of Yellow Water**

As set out above, on the basis of limited information, a level of 3 m high with culverts 2.44 m high was adopted.

**Culverts**

(1) **Pipes 2.44 m in diameter**

Initially, pipe culverts were tried; using 2.44-m culverts with \(~600\text{-mm} \text{ gap in between meant that 33 culverts could be placed, and, with minimal head loss, these would pass only } ~200 \text{ m}^3\text{s}^{-1}\).\)

Allowing for a head loss of \(~0.25\text{ m}\), the 33 pipes would pass the \(275 \text{ m}^3\text{s}^{-1}\) assumed as an annual flow.

Allowing for a head loss of 0.5 m, the number of 2.44-m-diameter pipes could be reduced to 25.

(2) **Box culverts 2.44 by 2.44 m**

Large box culverts can be more expensive to lay because they need a base slab. This can be offset to some extent because they achieve a greater area within a set width, and link slabs can be used between the boxes to cut costs. (Using link slabs works best with an uneven number of openings so that the two outside ones can be full culverts, with link slabs on every second opening in between.)

The most openings that could be put in the 100 m of river width would be \(~37\). Using this number of culverts to pass the \(275 \text{ m}^3\text{s}^{-1}\) would give a head loss of 0.13 m.

Using 27 openings to pass the same flow would increase head loss to 0.25 m.

Using 23 openings to pass the same flow would increase head loss to 0.35 m.

Using 19 openings to pass the same flow would increase head loss to 0.5 m.

(3) **Weir flow in bigger events**

Once the capacity of the culverts is exceeded, water will start to overtop the embankment and it would be desirable to keep depths and velocities over the weir to a minimum to limit the risk of failure.

Flow to be passed in the 100-year event is the \(2000 \text{ m}^3\text{s}^{-1}\), although some of this will go through the culverts. With no level information, it is not known how long the levee will be, and it could be shorter than calculated below if surface levels match top of the levee level at some point offset from the waterway.
If flood depth over the weir could be kept to 0.5 m, weir flow would be \( \sim 0.7 \, \text{m}^3 \, \text{s}^{-1} \, \text{m}^{-1} \) and a weir some 2.8 km long would be needed.

With a flood depth over the weir of 1 m, weir flow would be \( \sim 2 \, \text{m}^3 \, \text{s}^{-1} \, \text{m}^{-1} \) and a weir some 1 km long would be needed.

**Discussion**

- The weir or levee and culvert arrangement with floodgates will be expensive and could be prone to failure.

- Maintenance would be a minor issue with debris blocking the floodgates, but this would not be critical as they would still reduce salt intrusion.

- Detailed modelling of the effects of salt intrusion is recommended before any decision is made on building a hard-engineered structure.

- Modelling should also look at how long any high tide-induced salt intrusion would stay in Yellow Water and whether this would be detrimental to flora.

- If some barrier is required, something more natural at a lower level, say vegetated bars at normal water level as in a wetland, should also be modelled.

Keith Boniface

Melbourne Water
<table>
<thead>
<tr>
<th>Hard barrier</th>
<th>Soft barrier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Built with concrete or earth and large pipes</td>
<td>Build the land up naturally and allows mangroves to grow</td>
</tr>
<tr>
<td>Effective at stopping saltwater</td>
<td>They can be built with fallen trees, timber poles, bamboo matting and fish nets</td>
</tr>
<tr>
<td>They can protect high value land and property during times of flood</td>
<td>May provide opportunity for people to go to country</td>
</tr>
<tr>
<td>They block the river and floodplain</td>
<td>Soft barriers and healthy mangroves could protect some parts of the floodplains</td>
</tr>
<tr>
<td>Possible to build a special ramp to help fish move past</td>
<td>Soft barriers are not as strong as hard barriers</td>
</tr>
<tr>
<td>Very expensive to build (estimated ~A$700 000–A$1 800 000 km$^{-1}$)</td>
<td>They still cost a lot to build (estimated ~A$30 000–A$100 000 km$^{-1}$ for labour costs only and could use local materials) and maintain, but they are much cheaper than hard barriers</td>
</tr>
<tr>
<td>and maintain, and not suitable to protect all areas</td>
<td>Soft barrier may create more natural and adapted environments</td>
</tr>
<tr>
<td>Requires specific studies and modelling to get design right</td>
<td>They do not work as quickly as hard barriers and saltwater might still come past the barrier</td>
</tr>
<tr>
<td></td>
<td>This could provide time for people to learn how to build them in Kakadu and to create more diverse ecosystems</td>
</tr>
</tbody>
</table>
Google Earth KMZ file

I. Introduction

This document was created to help users of the Google Earth files that were generated as part of the Kakadu NERP project to open the spatial layers and interact/modify them. The document is a summary of several information sources and tutorials available on the web.

Google Earth (GE) is a virtual globe program that maps the Earth by the superimposition of images obtained from satellite imagery and aerial photography allowing viewers to visualize data of the Earth’s surface. Launched in 2005 and released to the public in 2006, Google Earth fast became a household name hailed as a revolution for humanitarian development, much as Geographic Information Systems (GIS) were several decades ago.

GE allows users to mark points, lines and areas (polygons) using a limited set of symbols. When used in to map environmental and cultural values, Google Earth allows users to map infrastructure, sites where animals and plants were observed, administrative, political, and cultural boundaries. The program can be used for many different purposes and different sectors of society.

This tutorial is designed to introduce Google Earth (free version) to users who wish to develop basic skills such as: customizing layers, creating placemarks (e.g. Balloons, which allows users to tell their own stories with images), polygons to delimit areas of interest, and paths which allows for features such as fly-overs, and other functions available in Google Earth.

II. Google Earth x Google Earth Pro

Google Earth Pro includes the same easy-to-use features and imagery as the free version of Google Earth, but with additional professional tools designed specifically for business users:

- Utilize data layers to locate target demographics
- Compute distances and areas using measurement tools
- Use Movie Maker to produce movies
- Print high-resolution images for presentations and reports
- Import large vector image files to quickly map GIS data
- Map addresses with the Spreadsheet Importer

---

Table 1: Main differences between Google Earth (free version) and Google Earth Pro. Adapted from Dodsworth (2008)

<table>
<thead>
<tr>
<th>Features</th>
<th>Google Earth</th>
<th>Google Earth Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>License</td>
<td>Download free on the internet (see <em>Downloading GE</em>)</td>
<td>Purchase Professional version for $400 annual subscription free</td>
</tr>
<tr>
<td>Geographical Contents</td>
<td>Identical in both versions. E.g.:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Satellite Imagery/Orthoimagery</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- StreetView</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Search for Points of Interest (schools, parks, hotels, etc.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Driving Directions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Explore featured content (Rumsey maps, National Geographic, etc.)</td>
<td></td>
</tr>
<tr>
<td>Geospatial Data Import</td>
<td>- Google Earth (KML, KMZ)</td>
<td>- Google Earth (KML, KMZ)</td>
</tr>
<tr>
<td></td>
<td>- GPS (.gpx, .loc)</td>
<td>- GPS (.gpx, .loc, .mps)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Imagery (<em>GeoTiff</em>)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ESRI (.shp)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- MapInfo (.tab)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ERDAS Imagine (.img))</td>
</tr>
<tr>
<td>Other Data Import</td>
<td>- Images (jpg, tif, png, gif)</td>
<td>- Images (jpg, tif, png, gif)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Text (.txt, .csv)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- GPS data imports for Magellan and Garmin devices</td>
</tr>
<tr>
<td>Mapping Tools</td>
<td>- Drawing Tools</td>
<td>- Drawing Tools</td>
</tr>
<tr>
<td></td>
<td>- Ruler Measure Distance</td>
<td>- Open Attribute Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Ruler – measure distances and areas incl. polygons and circles.</td>
</tr>
<tr>
<td>Screen Print and Save</td>
<td>- Prints lower quality images (1000 pixels)</td>
<td>- Prints higher quality images (4800 pixels)</td>
</tr>
<tr>
<td></td>
<td>- Saves lower quality jpg images (1000 pixels)</td>
<td>- Saves higher quality jpg images (4800 pixels)</td>
</tr>
</tbody>
</table>
III. Downloading and Installing Google Earth (Free Version)

Google Earth free version is available on the internet. To download, visit http://earth.google.com.

1. Click the ‘Download Google Earth’ button in the top right corner of the screen

2. Click ‘Agree and Download’
3. Click ‘Run’ to start installation

The program is now installed on your computer.

**IV. Common Functions**

Once opening Google Earth, the main window will be divided in 2 sections: The Earth appears on the right hand section and this area is called 3D viewer. The 3D viewer always appears in Google Earth and shows your imagery, terrain and information about places around the globe. On the left hand side is the legend and is used to control which data is shown, to find locations and to manage user and Google Earth data.

The right- and left-hand sections are divided in the following 5 sub-sections:

1. **Search bar** - Users can insert the name of a place, such as a country, city or other popular landmark and “fly to” it (e.g. type the name of the place you would like to “fly to”, such as “Kakadu National Park” and click Search).

2. **Places** – All layers and folders produced for Google Earth (e.g. the layers for the Kakadu NERP project) will appear in this panel. Placemarks (see Creating Placemarks) and shapes will also appear in this sub-section. Note that the “Temporary Places” folder appears by default. And layers imported to Google Earth will be initially placed in this folder and need to be moved to the ‘Places’ sub-section after importing to Google Earth.

3. **Layers** – In this sub-section users can explore layers available in Google Earth and created by other GE users and choose to hide or reveal these layers, which can add new features to your existing project (e.g. roads, hotels, and other points of reference).

4. **Toolbar** – There are several tool options in this sub-section which allow customizing maps (eg. placemark, polygon, path, history, record a tour, set the time of day using sunlight across the landscape, etc).

5. **Navigation controls** - Use the arrows to zoom in and out of the globe and control the camera to view maps in unique perspectives, including tilting and rotating the view.

---


Navigating on the Earth

The navigation controls are composed for 4 parts:

1. North (N) - click the north-up button to reset the view so that north is at the top of the screen. Click and drag the ring to rotate your view.

- Practice – Resetting the view of the extent of saltwater inundation in a 2070 sea level rise scenario on freshwater floodplains on Kakadu National Park

---

2) Look joystick - look around from a single vantage point, as if you were turning your head. Click an arrow to look in that direction or continue to press down on the mouse button to change your view. After clicking an arrow, move the mouse around on the joystick to change the direction of motion.

➢ Practice 1 – Click to look around any area in Kakadu National Park

---

3) Move joystick - to move your position from one place to another. Click an arrow to look in that direction or continue to press down on the mouse button to change your view. After clicking an arrow, move the mouse around on the joystick to change the direction of motion.

➢ Practice 2 – Click to move around any area in Kakadu National Park

---

4) Use the zoom slider to zoom in or out (+ to zoom in, - to zoom out) or click the icons at the end of the slider. As you move closer to the ground, Google Earth swoops (tilts) to change your viewing angle to be parallel to the Earth's surface. You can turn off this automatic tilt (Tools > Options > Navigation > Navigation; Mac: Google Earth > Preferences > Navigation > Navigation controls).

- Practice 3 – Click to Zoom in and out of the extent of saltwater inundation in a 2070 sea level rise scenario on freshwater floodplains on Kakadu National Park

  Step 1 – Zoom in to a specific location.

Step 2 – Zoom out: When you finish zooming into extent of saltwater inundation in a 2070 sea level rise scenario on freshwater floodplains on Kakadu National Park you can now zoom out. Just click on the “-” button until you get the view of the region you want.

---

Street View

To view street-level imagery for a specific location, zoom into an area, such as Jabiru. You will see a pegman icon appear at the top right corner below the navigation controls.

➢ Practice 4

Step 1 - Click and drag the icon across the 3D viewer in a street in Jabiru.

---

Step 2: Note that when dragging the icon a blue border will appear around roads that have street-level imagery available then you can choose areas where there are the blue border to use street view.

Step 3: You can activate the Street View button to navigate along the streets using all navigating controls or your mouse. To come back to 3D Viewer, you can exit Street View selecting the Exit Street View button located at the top right corner.

NOTE: If you don't see navigation controls on the top-right corner of the 3D viewer, you may have disabled them. Go to View > Show Navigation and make sure Automatically or Always is selected.
Creating Placemarks

A placemark is a point that allows marking and storing any location in the 3D viewer on Google Earth. When creating a new placemark, the layer will be added into “My Places” folder in the Place panel. This folder is created by default appearing automatically when opening Google Earth and it is the place in which the users’ generated information is stored\(^9\). To add a placemark simply follow the following instructions from the Google Earth User Guide\(^1\):

- Position the 3D viewer to contain the spot you want to placemark. Consider zooming into the best viewing level for the desired location. Choose any one of the following methods:

  a) Select Placemark from the 'Add' Menu.

  b) Click the Placemark icon in the toolbar menu at the top of the screen.

  c) Right click on the selected folder in Place panel, select Add> Placemark

---


The 'New Placemark' dialog box appears and a 'New Placemark' icon is centered in the viewer inside a flashing yellow square. The example below adds a ‘Placemark’ in Boggy Plain. To do this, position the cursor on the placemark until the cursor changes to a pointing finger and drag it to the desired location. The cursor changes to a finger pointing icon to indicate that you can move the placemark.

Practice 5 12 – Editing the placemark. In this practice we will create a new placemark for Cooinda Airport located in Kakadu National Park. Let’s follow the steps below to edit our new placemark:

1- Find Cooinda Airport in the section 3D Viewer. The quickest way to do it is typing the name’s location in Search panel.

2- Add a placemark choosing one of the options (a,b or c) above. The quickest way is clicking in the placemark icon in the toolbar menu. The new dialog box appears and a placemark icon will appear in Cooinda Airport in the 3D Viewer.
3- In the Google Earth - New Placemark dialog box, enter the following information:

- **Name:** "Cooinda Aiport"
- **Description:** "Cooinda has no commercial airport but an airstrip for small aircraft. There are no regular air services to Cooinda."
- Google Earth's default placemark is a yellow pushpin. You can change the placemark icon by clicking the placemark button to the right of the Name field and selecting a new icon. You can even add a custom placemark icon that corresponds to a local image or web image.
- Click OK. Google Earth displays your placemark in the 3D viewer and at the selected folder in the Places panel.
To visualize the placemark balloon, double-click the placemark in the 3D viewer or in the Places panel.

To delete the placemark, right-click the placemark in the 3D viewer or in the Places panel and choose Delete.
Practice 6 – Editing the placemark. This practice we will insert an image into our Cooinda Airport placemark description.

- You can use one of your photos or alternatively you can download the photo ‘Sunset at Cooinda’ by Roger Bradley (licence under creative commons in Flickr: [https://flic.kr/p/a5CyCm](https://flic.kr/p/a5CyCm)).
- Save the photo in your local hard drive.
- Open the dialog box by right-clicking the placemark in 3D viewer or in Places panel and select Properties.
- In the Description box (bellow the text which we have inserted in Practice 1) type the following html code `<img src = “`
- Copy and paste the file path for the image and finish off the code with ”>`
- Click ok.

---


14 Image and text were extracted from [http://www.kakadunationalparkaustralia.com/Cooinda_Airport.htm](http://www.kakadunationalparkaustralia.com/Cooinda_Airport.htm) (accessed September 03, 2014)
If you want to change the size of the picture then you need to add width="800" (or any number of pixels) and height="400". Experiment with putting in different numbers until you get the size of image that you want.
Creating StoryBox - Balloons

Google Earth has done many HTML templates to help users when creating their own balloons. You can download the templates use for Practice 7 at:


Practice 7 - Adding the Balloon Template

1- Open the KMZ file (Wide Photo KMZ) available at:

2- Import this file in GE: file>open> C:\balloons_templates. The sample placemark contains sample text and images, and the template placemark contains placeholders for you to customize.

Note the template will be located in Temporary Places folder in the Places panel and this balloon was created inspired by American Institute Architects layer and the location is in San Francisco (USA).

Practice 8 - Customizing your own Balloon using the HTML Template

1- In GE, type Jim Jim Falls in Search Panel and click Search.
2- Add a placemark and Edit the name for Jim Jim Falls using methods shown in Create Placemarks.
3- Drag Jim Jim Falls placemark to My Places in the Places Panel.
4- Copy the HTML for the Template placemark ‘Wide Photo’:
   - right-click the template placemark.
   - Select Properties from the context menu.
   - In The Description tab select all HTML for the placemark.
   - Right-click Select Copy and close the dialog box.
5- Paste the HTML from the ‘Wide Photo’ template to the description tab of the Jim Jim Falls placemark
   - right-click the Jim Jim Falls placemark.
   - Select Properties from the context menu.
   - In The Description tab right click and paste.
6- Customizing the HTML section:
   - In the comment section at the top, each placeholder appears (all caps in curly braces, such as {LOGO_URL}) followed by its description. Don’t worry, this comment section won’t appear in the actual balloon.
   - In the HTML section below the comments, find and replace each of the placeholders with your own text or links to images. Be sure to replace the entire placeholder, including the curly braces and you can delete that placeholder which you don’t need to use. In our example as we are not talking about an organization we don’t need to use the placeholder {LOGO_URL}.
   - Click OK.

A helpful feature in Google Earth is the ability to draw a line, or path, over a particular region so that you can navigate/fly over it. You can draw free-form paths in the 3D viewer and save them in your My Places folder just as you would a placemark. Paths share all the features of placemark data, including name, description, style view, and location. Once you create a path, you can even select and play a tour of it.

➤ Practice 9 Adding a path in Google Earth

1. Position the 3D viewer to best contain the region you want to mark. In the example below we are using Jabiru. The more detailed your view, the more closely your drawing can follow the land feature.
2. From the Add menu, select Path (Ctrl + Shift + T), or click the Add Path icon on the toolbar.

2. The New Path dialog box appears and the cursor changes to a square drawing tool. Click in the viewer to start your drawing.

---

3. Setting Line Color and Width
With the New Path dialog box open, you can use the Line properties in the Style, Color tab to modify the display of the line in the 3D viewer. You can even make the line invisible!
4. Fly over the path

- Double click the path in the Places panel.
- Click the Play Tour button. The tour begins playing in the 3D viewer and the tour controls appear in the bottom left corner of the 3D viewer.
Importing Data from Google Earth to ARCGIS and vice versa

1. From GE to ARCGIS

Google Earth files can be of two file extensions: 1) KML is an XML-based language provided by Google for defining the graphic display of spatial data in applications such as Google Earth and Google Maps., and 2) KML enables these applications to support the open integration of custom data layers from many GIS users. KML is a popular format for sharing data across the Internet and for use in online mapping applications. Its default projection of WGS84 allows it to be displayed and used in a variety of GIS applications\(^\text{18}\). A KMZ file consists of a main KML file and zero or more supporting files that are packaged using a Zip utility into one unit, called an archive. The KMZ file can then be stored and emailed as a single entity\(^\text{19}\). Translating KML and KMZ files into feature classes inside a geodatabase allow these common features to be used in ArcGIS.

- **Practice 10: Exporting Jim Jim Falls placemark to ARCGIS**
  - In GE in the Place Panel right click the Jim Jim placemark
  - Select Save Place as
  - In Save as Type select the option Kml (*.kml)
  - Check if the file is the desired location and click save
  - In ArcGIS ArcToolbox > Conversion Tools > From KML > KML to Layer
  - Set the KML file address in Input File, choose a location for your new ARCGIS layes in Output Location and click ok.

- Output will be generated in the WGS84 coordinate system but it can be reprojected to another coordinate system using the Project tool.

---


\(^19\) "KMZ Files", accessed September 11, 2014 [https://developers.google.com/kml/documentation/kmzarchives](https://developers.google.com/kml/documentation/kmzarchives)
2. From ARCGIS to GE

There are two geoprocessing tools available for creating KML files from ArcGIS data: Layer To KML and Map To KML. Both tools create a KMZ (compressed KML) file in the output location.

- Practice 11: Exporting the ASCII file WV2 2012 Hymenachne to GE
  - In ARCGIS ArcToolbox > Conversion Tools > To KML > Layer To KML
  - Set the ASCII file address in Layer, choose a location and a name for your new KML in Output file.
  - In Environments > Output Coordinates choose the same coordinates as the ASCII file and click ok. Finally, go to GE and open your KML in GE.
Communications brochure for the Sea Level Rise project on Kakadu National Park
Why have we made this booklet?

In December 2013 we held a workshop for Kakadu Traditional Owners to talk about the potential impacts of sea level rise on country, and possible management solutions to deal with it. Some people who attended the workshop said that they would like us to print the information in a booklet so that they can show to other people living in Kakadu and to talk with them about future sea level rise and saltwater inundation. This booklet is a living document, and comments and suggestions on how to make it better as we provide continuous updates are welcome.

Why are we looking at sea level rise in Kakadu?

Scientists believe that climate is changing and sea levels are rising. This is because more and more people are clearing the land and burning fuels for power and transport. These activities are changing the atmosphere and making the world warmer. Warmer temperatures are causing sea levels to rise, and more extreme weather like floods, cyclones and very hot days.
People are starting to notice these changes. Over the past 20 years, sea levels in northern Australia have risen from between 7 and 11mm each year. There is strong agreement that we need to understand as much as possible about the effects of climate change in Kakadu National Park.

Currently weeds and feral pigs are recognised as the biggest threats to floodplain health in Kakadu, and efforts are being made to deal with them. Sea level rise is a future threat. It will bring saltwater onto freshwater floodplains, changing the environment.

Understanding how sea level rise might push saltwater inland is important because the tides in northern Australia are big and the floodplains in Kakadu are flat.

Even a small rise in sea level might push saltwater onto large areas of freshwater floodplains, which might kill wildlife and plants.

Sea levels are rising slowly, so we have time to think about how we can manage saltwater entering the floodplains and how this may change the environment and bush tucker areas.

Bininj have already provided information about how this may affect plants, animals, places and important cultural practices. We are working with Bininj and Parks to understand how this information can be used to manage country and which areas to prioritise.

**Floodplains had saltwater species before**

Scientists believe that Kakadu’s floodplains were under saltwater before. Thousands of years ago sea levels were higher, bringing animals like barramundi, mullet and saltwater crocodiles to the areas that we now know as freshwater floodplains. Rock art on Kakadu floodplains show saltwater animals in the floodplains. Scientists think this could be how freshwater floodplains would look in the future if sea levels rise again.

**Who is involved in this project?**

Researchers from CSIRO, Charles Darwin University, Griffith University and eriss are working with Bininj and Parks staff to estimate how much of the floodplain might be covered by saltwater in the future, and how this might change the environment.

Bininj have already provided information about how this may affect plants, animals, places and important cultural practices. We are working with Bininj and Parks to understand how this information can be used to manage country and which areas to prioritise.

**Floodplains had saltwater species before**

Scientists believe that Kakadu’s floodplains were under saltwater before. Thousands of years ago sea levels were higher, bringing animals like barramundi, mullet and saltwater crocodiles to the areas that we now know as freshwater floodplains. Rock art on Kakadu floodplains show saltwater animals in the floodplains. Scientists think this could be how freshwater floodplains would look in the future if sea levels rise again.
How were the freshwater floodplains formed?

Eight thousand years ago sea levels began to get lower. Over time the animals and plants on the floodplains changed from the ones that can live with salt, like mangroves and crabs, to freshwater species like red lilies, water chestnut and magpie geese.

The floodplains have been freshwater for around 1,500 years. Rock art from this period shows that the new freshwater floodplains brought new bush tucker, like water lilies and magpie geese, which are still used by Bininj today.

How do the floodplains work?

Floodplains are fully covered by freshwater during Gudjewg (the wet season), and almost completely dry during Gurrung (the dry season). Plants and animals need the floodplains to be covered by freshwater during Gudjewg to live.

Throughout Gudjewg the rains bring freshwater into the catchments and main rivers of Kakadu (Wildman, West, South, and East Alligator). This freshwater spills out onto the floodplains and flows through the main river channels to the sea. It pushes the saltwater at the mouth of the river back and no saltwater comes onto the floodplain, even when the tides are high.

Throughout Gurrung there is almost no rainfall and saltwater can travel to the upper reaches of Kakadu’s rivers. In the South Alligator River, saltwater can travel as far up as Yellow Water during high tides. It enters floodplain areas through narrow channels during high tides, and normally stays in these channels. Saltwater plants like mangroves grow in these areas.

Saltwater only reaches freshwater plants in very high tides (king tides), which happen about twice a year around December and July. Some Bininj notice when saltwater enters the floodplains. It changes the smell, colour and feel of the water. People say they can feel saltwater as it stings cuts on their skin. Some people have told us stories about their efforts to stop the saltwater, like building small barrages.
Alligator River Region Flood Extent - March 2010

This is an example of areas that flood in the wet season.

Source: Doug Ward / Griffith University
What will sea level rise do to the floodplains?

In the last 20 years sea levels have risen quickly – about 6cm (see Figure). This is probably the reason that Bininj have seen saltwater coming to areas like Gina.

In the next 50 years sea levels may rise up to 70cm more. Our maps show that this amount of sea level rise could change the floodplains a lot. Freshwater areas may become saltwater country even during Gudjewg. Because the sea level will be higher cyclones won’t need to be very strong to bring saltwater further onto the floodplains.

![Proportion of floodplain affected by saltwater (Stage 1 - SLR)](image)

This photo shows floodplain channels (about 1.5m wide) covered by saltwater during high tides in dry season. Only salt-tolerant species like the mangroves in the background can grow in these areas. (Photo: Sandra McGregor).
This shows the areas that are affected by saltwater now.

Yellow shows the areas that could be affected by saltwater two generations from now. Blue is showing areas currently affected.

Sea level rise may change hunting and fishing sites

Sea level rise might be hard for us to notice over a few years but over many generations it may bring saltwater to freshwater places where Bininj now hunt and fish. It could be harder to go to these places because the tracks might be underwater and people will need to find other ways to go hunting and fishing.
How will plants be affected?

When floodplains get covered by saltwater the plants that live and grow there could change. At first, some plants like red lilies might die and others might grow. Some saltwater every now and then can help plants like water chestnut to grow better, which is also good for magpie geese. But when saltwater becomes deeper these plants will go, and more saltwater plants like mangroves may take their place.

*Water chestnut, key component in the diet of magpie geese (photo above), should do well with a bit of saltwater in the beginning, but should go when saltwater becomes deeper.*

Photo: CSIRO
All paper barks at the edges of the floodplains should go as they cannot live in saltwater.
How will animals be affected?

Sea level rise may change the shape of rivers and creeks, and new saltwater plants will bring different animals.

- Turtles might move.
- Magpie geese might lose their nesting areas.
- Magpie geese and whistling ducks could be affected as they depend on freshwater plants.
- File snakes could be affected, because they like to be in the paper barks.
- There might be more barramundi because they like saltwater.
- There might be less black bream because they only live in freshwater.
- New freshwater floodplains might be created as saltwater pushes the freshwater into new areas. But these won’t be as big as the existing freshwater floodplains because the terrain means there aren’t other large flat areas where the freshwater can go.
- As the saltwater area increases, there will be more saltwater crocodiles.

How can we respond?

Bininj and Parks staff think that saltwater from sea level rise will change freshwater places but it may also create new freshwater areas. Keeping the floodplains healthy by controlling weeds and pigs will make it easier for freshwater plants to survive in the new freshwater places.

There are different types of barriers that could also be suitable to protect some areas from too much saltwater. A barrage is another name for a barrier.

Can we build something to protect an area from saltwater?

There are different types of barriers that can be used to prevent saltwater from coming on to freshwater floodplains. Some of them have been used in the Mary River. We looked at two options that may help protect some floodplains:

1. A hard barrier that stops saltwater entering the floodplains during Gurrung (the dry season) and allows freshwater to flow during Gudjewg (the wet season).

2. A soft barrier to protect the coast and encourage mangroves to grow.

Hard barriers are built with concrete and large pipes to allow freshwater to flow during Gudjewg but to stop saltwater from coming in. They can be very good at stopping saltwater and are strong enough for areas where there is high water flow or lots of erosion. They can protect high value land and property during times of flood.

One problem with hard barriers is that they block the river and floodplain and can make it hard for fish, other animals and boats to move between the floodplains and the estuary. It is possible to build a special ramp in the barrier to help fish move past, but some fish might still be affected.

Hard barriers are also very expensive to build and are not suitable to protect all areas. There are also expensive ongoing costs to maintain them.

Soft barriers build the land up naturally by slowing the water, trapping sediments and allowing mangroves to grow.
They can be built with fallen trees, timber poles, bamboo matting and fish nets. Soft barriers will not work at all in areas where the water flows and waves are too strong.

Soft barriers and healthy mangroves could help stop saltwater from sea level rise spreading across some parts of the floodplains. Soft barriers are not as strong as hard barriers in storms. They still cost a lot to build and maintain, but they are much cheaper than hard barriers. Using a soft barrier may create more natural environments.

These types of barriers don’t work as quickly as hard barriers because it takes years for natural material to build up and trap sediments, and even longer for healthy mangroves forests to grow. It could take more than 10 years for a soft barrier to work properly and saltwater might still come past the barrier.

Yellow Water is a very important area to many people. Some people have asked if there is a way to protect it. It may be possible with a either a hard or soft barriers but more research is needed about whether this would work.

Monitoring change

Bininj and parks identified that an important component of managing SLR effects would be to monitor to what extent saltwater travels into floodplains during very high tides, storm surges and the coincidence of the two effects. Additionally, it would be important to measure at the same time how saltwater is changing the composition and dynamics of floodplain plants and animals.
References


BMT WBM (2011). ‘Kakadu: Vulnerability and Climate Change Impacts.’ (Department of Climate Change and Energy Efficiency: Brisbane, Qld, Australia.)


CSIRO (2013). Submission to the Senate Standing Committee on Environment and Communications inquiry into recent trends in and preparedness for extreme weather events. CSIRO Climate Adaptation Flagship, CSIRO Submission 12/471, Brisbane, Qld, Australia.


Tremblay, P. (2006). 'The Economic Contribution of Kakadu National Park to Tourism in the Top End of the Northern Territory.' (CRC for Sustainable Tourism: Darwin, NT, Australia.)
